GRAPHISOFT®


Library Part Maker 20 User Guide
Graphisoft UK would like to thank all participants for their valuable contributions to this add-on release of Library Part Maker for ARCHICAD in the UK and Ireland.
Special thanks go to GRAPHISOFT Library Part Maker Team.

Rob Kalocay
Product and Technical Manager for UK and Ireland

Copyright © 2016 by GRAPHISOFT, all rights reserved. Reproduction, paraphrasing or translation without express prior written permission is strictly prohibited.

Trademarks
ARCHICAD® is a registered trademark of GRAPHISOFT.
All other trademarks are the property of their respective holders
Contents

Introduction .................................................................................................................. 2
BIM Library Part Concept .................................................................................................. 2

Add-on Installation and Content ................................................................................. 3
Installation ..................................................................................................................... 3
Template ......................................................................................................................... 3

Scope and Basic Concepts ............................................................................................. 3
LPM Model View Options (MVO) tab ............................................................................ 4
Use of Layers ................................................................................................................ 4
Use of Attributes ............................................................................................................. 4
Property Schema(s) definition ...................................................................................... 4
Level of Detail (LOD) concept ...................................................................................... 5
Recommended 2D Symbol Level of Detail .................................................................... 5
Recommended 3D Model Level of Detail ....................................................................... 6
2D Symbol and 3D Model Layer Content Origin ......................................................... 8

Library Part Design ......................................................................................................... 9
Creating 2D Symbols ...................................................................................................... 10
Definition of Door/Window Tolerance .......................................................................... 10
Creating 3D Models .................................................................................................... 11
Creating Door/Window/Skylight Opening Lines ......................................................... 13
Positioning of Door/Window Handle & Lock Assembly .............................................. 14
Predefined / Custom Handle and Shutter panels content ........................................... 15
Door and Window Standard Fixtures and Fittings ....................................................... 16
Library Part Maker Palette ........................................................................................... 17
Selecting and checking content for saving .................................................................. 17
Updating Existing Library Part ................................................................................... 17
Adjusting Library Part Parameters and Attributes .................................................... 18

Customising Data Properties ......................................................................................... 20
Creating Custom Property Schema ............................................................................. 20
Importing data from Excel spreadsheet ....................................................................... 20
Introduction

To assist our customers Graphisoft have developed a new ARCHICAD add-on that simplifies and streamlines custom GDL-based library parts. The current release is limited to the scope of a technology preview that will hopefully be a stepping stone for further improved ARCHICAD features in this area.

The Library Part Maker aims to provide a robust approach with the focus on delivering the ‘i’ in BIM as standard based on BS8541-1/2/3. The add-on creates a data driven approach that allows design freedom to remain central to the user. This strongly complements Graphisoft’s approach to creating a tool for designers and is key to giving architects the freedom to create anything.

The template will also assist in improving IFC exchange by standardising the stored data organisation in library parts for the user and seek to make COBie-UK-2012 an in-built standard for all its users. This should assist all users seeking to deliver COBie to their clients and make data exchange more robust and more reliable. The add-on also seeks to be compatible with international approaches.

Having a standard approach in library parts development will allow better training material to be developed and in time also allow UK and Ireland companies to employ staff without needing to retrain where an employee has worked for another UK or Ireland firm.

BIM Library Part Concept

The concept of BIM Library Part is based on delivering ‘i’ in BIM reliably. That means all parts of the library part content such as 2D Symbol, 3D Representation and especially Information data structure must be synchronised. In other words changing 2D symbols and/or 3D models should be reflected in library part information data structures and vice versa. Although GDL Technology supports this approach the implementation requires advanced GDL programming skills that can render the maintenance and redistribution overhead as unfeasible. LPM approach focuses on the industry ‘real-life’ manufactured products where the geometry and information is firmly tied together (e.g. a certain type of product has always the unique bar code number) however LPM still allows for parametric 2D/3D (LOD-based) and parametric CAD (ARCHICAD Attributes) 2D symbols and 3D models. Also LPM greatly simplifies creation and design of complex openings in ARCHICAD.
Add-on Installation and Content

Installation
1. Close all running instances of ARCHICAD
2. Run the Installer package.
3. Restart ARCHICAD
4. Choose the template Library Part Maker Template 20 (see the Template topic below)

Template
The ARCHICAD template provided with the add-on contains necessary add-on libraries as well as examples, layers, layer combinations and attributes that can speed up your design process. Start a New Project and select Library Part Maker template from the list of available templates.

Scope and Basic Concepts
The Library Part Maker (LPM) workflow is based on the use of standard 2D and 3D ARCHICAD toolbox tools completely eliminating a need for any knowledge of GDL programming. Current release of LPM provides tools for creating all basic GDL library types and 2 accessories.
Object types:
1. Generic Object
2. Window
3. Door
4. Skylight
5. Lamp

Accessories:
1. Door/Window Handles
2. Window Shutters
LPM Model View Options (MVO) tab

LPM creates new tab in MVO called Settings for Library Part Maker Elements that allows ARCHICAD users to control global appearance of library parts created by LPM with saved Views in View Map.

Use of Layers

LPM uses layers for definition of different functional parts in a designed library part. The detailed breakdown of layers and the functionality they cover is explained in Library Part Design section.

Use of Attributes

LPM maps used Attributes (pens, fills, surfaces) of 2D symbols and 3D models and offers them as parameters in the saved library part. The initial names of parameters are automatically derived from the name of the actual Attribute however parameter names and values can be manually customised from the user interface that LPM add-on provides before the library part gets saved.

It is recommended to consolidate and check the toolbox tools attribute settings before you draw or model library part definitions in order to avoid a large number of unwanted attributes as parameters in the library part user interface. Setting up your tool attribute settings in Favourites palette is the best way to minimise errors and avoid laborious process of checking the tool attribute settings every time.

Property Schema(s) definition

LPM uses default ARCHICAD parameter schema and NBS BIM Object Standard 1.3 http://www.nationalbimlibrary.com/nbs-bim-object-standard for listing however it is possible to create any number of custom parameter schemas used for listing purposes. Please refer to the detailed description in Library Part Design section.
Level of Detail (LOD) concept

LPM introduces following levels of detail for 2D and 3D representations.

2D:
- **1:200/NBS BIM ToolKit LOD 2/BS8541-2 LOD “Low”**
- **1:100/NBS BIM ToolKit LOD 3&4/ BS8541-2 LOD “Medium”**
- **1:50 /NBS BIM ToolKit LOD 5/ BS8541-2 LOD “High”**
- **Electrical Symbol**
- **Reflected Ceiling Plan Symbol**

3D:
- **BS8541-3 LOD “Schematic”/NBS BIM ToolKit LOD 2/Sketch Design**
- **BS8541-3 LOD “Coordinating”/NBS BIM ToolKit LOD 3&4/Planning Permit**
- **BS8541-3 LOD “Visualisation”/NBS BIM ToolKit LOD 5/Building Regulations and Documentation**

The LOD representations can be controlled from either the new Model View Options Settings for Library Part Maker Elements tab or from the user interface of each individual instance placed in the project model.

Note:
It is possible to skip some of LOD definitions, e.g. user can define just “Low” and “High” options and no “Medium” option. The library part will automatically use only defined representation should the user select a non-defined level of detail option. However this practice is not recommended as it can lead to unexpected 2D/3D representations of library part in documentation and 3D model views with certain scale or Model View Options settings.

**Recommended 2D Symbol Level of Detail**

Consider the pen thickness and detail appearance at scale – too detailed 2D representations for larger scales could appear and/or print with a compromised legibility.

**Examples of 2D Symbol Level of Detail:**

- **Window**

- **Door**
Recommended 3D Model Level of Detail

Creating very detailed 3D models can lead to a heavy polygon count that can slow down ARCHICAD. Considering this aspect here are some hints that will help you to create library parts without compromising the performance:

- Avoid modelling details legible at scales less than 1:20 in general (e.g. 1:10 or 1:5 etc)
- Simplify shapes of frame/sashes sections or assembly profiles
- Do not model unnecessary elements (if possible) such as door/window seals, detailed door/window ironmongery, fasteners and similar.
- Avoid creating an excessive number of curved surfaces.
- Creating curved surfaces with very small radii will result in faceted faces so the best approach is to simplify them. (A typical example for the simplification use would be extruded steel/aluminium profiles of door or window frames and sashes).
- Use Morph tool (plane with zero thickness) for elements that are supposed to appear as a single line in Sections (e.g. glazing panes or door leaf/window sash in “Schematic” 3D LOD).
Examples of 3D Model Level of Detail:

Window

Door
2D Symbol and 3D Model Layer Content Origin

Use Level Dimension Tool from ARCHICAD toolbox for placing layer origins in Plan window. The layer origin position determines alignment of 2D Symbol and 3D Model content when the library part is saved. **Note that the layer origin must be placed on each used 2D Symbol and 3D Model layer separately.**
Library Part Design

Design Principles for Objects and Lamps
Layer Content Origin can be placed at any position as long as it is aligned with other layer origins. The recommended approach is to place the origin in the centre of an object or its bounding box (in case of irregular 2D symbols and 3D models). Additionally for lamps, 3D Representation requires placing at least on light source on the dedicated LPM layer.

Design Principles for Doors and Windows
A special methodology applies in case of Door and Window library parts. Layer origins for 2D door/window symbols must be aligned with the centre of door/window wall opening and the external edge of wall they will be placed in. Layer origins for 3D door/window models must be aligned with the bottom centre of door/window wall opening.

Position of layer content origins of door and window in Plan window:

Design Principles for Skylights
The same methodology applies as in case of Door and Window for 3D Representation. The 2D Symbol will be automatically created by the system as 2D projection of 3D Representation.
Creating 2D Symbols

Used Layers
LPM 2D Symbol High - Content of this layer will be used for 2D symbol with LOD 1:50
LPM 2D Symbol Medium - Content of this layer will be used for 2D symbol with LOD 1:100
LPM 2D Symbol Low - Content of this layer will be used for 2D symbol with LOD 1:200
LPM 2D Symbol Electrical - Content of this layer will be used for 2D electrical symbol (Generic object and Lamp relevant only).
LPM 2D Symbol Reflected Ceiling Plan - Content of this layer will be used for 2D RCP symbol. (Generic object and Lamp relevant only).

Design Principles
1. Draw 2D symbol(s) using any of standard 2D ARCHICAD tools and place them on relevant layers specified above. In case of door/window the 2D symbol orientation must be aligned with horizontal axis (x). The external face of opening should face up (see the Examples of 2D Symbol Level of Detail section).
2. Use Hotspot Tool to define custom 2D hotspots (effective for 2D Symbols only)
3. Place Layer Content Origins on relevant layers.
4. Any library parts used in your 2D symbols should be exploded to 2D primitives (lines, arcs, polylines etc)

Definition of Door/Window Tolerance
The Wallhole is the part cut out of the wall to accommodate the whole door/window structure.
Wallhole Width is equal to Unit Dimension Width plus any Horizontal Tolerance.
Wallhole Height is equal to Unit Dimension Height plus any Vertical Tolerance.

Used Layers
LPM 2D Tolerance High - Content of this layer will be used for Tolerance 2D symbol with LOD 1:50
LPM 2D Tolerance Medium - Content of this layer will be used for Tolerance 2D symbol with LOD 1:100
**LPM 2D Tolerance Low** - Content of this layer will be used for Tolerance 2D symbol with LOD 1:200

**Design Principles**
The tolerance 2D symbol must be drawn (using ARCHICAD 2D tools) always on the left hand side of the door/window 2D symbols with the same width for all used 2D symbols in a door/window library part.

The 2D tolerance symbols will be then automatically added to right, top and bottom door/window edges and they will be parametrically adjusted to Wallhole edges. The 3D model will be created automatically based on the tolerance width defined in 2D Symbol and the door/window frame thickness. The tolerance width and tolerance surfaces will be automatically added to the door/window user interface as parametric values.

![Tolerance Symbols](image)

**Creating 3D Models**

**Used Layers**
- **LPM 3D Model Visualisation** - Content of this layer will be used for 3D symbol with LOD Visualisation
- **LPM 3D Model Coordinating** - Content of this layer will be used for 3D symbol with LOD Coordinating
- **LPM 3D Model Schematic** - Content of this layer will be used for 3D symbol with LOD Schematic

**Design Principles for Objects and Lamps**
1. Model 3D representations using any of standard 3D ARCHICAD tools and place them on relevant layers specified above.
2. Place Layer Content Origins on relevant layers.
3. Any library parts used in your 3D model should be converted to morphs
4. Lamps only – place at least one light source located in Library Part Maker Templates 20/ Light sources on LPM 3D Model Visualisation layer

**Design Principles for Doors and Windows**
Note that current release of LPM allows for definition of openings with the rectangular non-parametric Wallhole shape only.
A special modelling methodology applies in case of Door and Window library parts. Once a door/window is inserted into a wall, the default position of these library parts’ coordinate system is rotated so that the x-y plane is vertical and the z axis points horizontally into the wall. The origin is placed on the bottom center of the wall opening, on the exterior side of the wall. This way, doors/windows can be easily modeled by elements in the x-y plane. See the illustrations below.

![Design position](image1)

![Saved library part position](image2)

The symbol and the 3D shape are fitted to the Door/Window origin by the lower (y) center (x) of the bounding box, but no adjustment is made along the z axis to enable users to design doors/windows extending beyond the wall in either z direction. Considering these rules, here are some hints that will help you construct doors/windows that will work properly:

- When constructing the door/window in the floor plan window, visualise it as if you are looking at it from the inside of the wall it will be inserted into.
- Think of the project zero level as the external surface of the wall.
- Elements that should be inside the wall, like the window frame, should be above the zero level.
- Door panels opening to the outside should be below the zero level.
- Don’t forget to place Layer Content Origins on each used layer

**Design Principles for Skylights**

The same principles apply as defined in Door/Window section. Additionally a freeform fill placed on LPM 3D Model Visualisation layer will define the roofhole of skylight.
Creating Door/Window/Skylight Opening Lines

Used Layers

**LPM Opening Line Hinges Visualisation** - Content of this layer will be used for Hinges Opening Line orientation with LOD Visualisation
**LPM Opening Line Hinges Coordinating** - Content of this layer will be used for Hinges Opening Line orientation with LOD Coordinating
**LPM Opening Line Hinges Schematic** - Content of this layer will be used for Hinges Opening Line orientation with LOD Schematic
**LPM Opening Line Lock Visualisation** - Content of this layer will be used for Lock Opening Line orientation with LOD Visualisation
**LPM Opening Line Lock Coordinating** - Content of this layer will be used for Lock Opening Line orientation with LOD Coordinating
**LPM Opening Line Lock Schematic** - Content of this layer will be used for Lock Opening Line orientation with LOD Schematic

**Design Principles**

![Lock Opening Line orientation](image1)
![Hinges Opening Line orientation](image2)

LPM allows to define any number and directions of Opening Lines and/or Opening Operation symbols in 3D Models by using 3D ARCHICAD tools. The 3D opening lines can be defined by Morph tool (set to the Line Geometry Method) however it is possible to use e.g. the 3D Text library part (from standard ARCHICAD library) to define any fixed text annotations.

Considering the use of varying standards for the direction of opening lines, LPM provides 2 sets of layers that define either “Hinges” or “Lock” opening line orientation. If the both definitions are used LPM will automatically set a controlling parameter in Model View Options and library part user interface that allows the user to flip their positioning as needed. Note the opening operation symbols that do not require flipping must be copied to both Hinges and Lock designated layers in order to make them visible in both modes.
Positioning of Door/Window Handle & Lock Assembly

Note that the option for 3D Lock&Handle assembly is available for 3D “Visualisation” LOD only.

Used Layers

**LPM Handles Internal Visualisation** Content of this layer will be used for Lock and Handle assembly on internal face of opening

**LPM Handles External Visualisation** Content of this layer will be used for Lock and Handle assembly on external face of opening

LPM allows definition of any number and directions of Lock&Handle assembly types separate for interior and exterior faces of an opening. The type of Lock&Handle assembly can be selected from standard types bundled in *Library Part Maker.lcf* library. In addition any Custom Component Handle library parts (in loaded libraries) can be used as well.

Design Principles

Use the 3D lines that can be defined by Morph tool (set to the Line Geometry Method)

Definition (Morph line)

The morph origin will be used as the anchor point (in 3D space, so the morph line must be positioned on door/window surface) and the direction of line will be used for Lock&Handle assembly orientation. The length of the line does not have any affect on the final handle position or shape. The relationship of a morph line used for design and the final Handle model is illustrated below:
Layer use will define handle orientation with regards to Internal or External face of a door or window. See *Creating 3D Models* for door and window orientation methodology.

**Predefined / Custom Handle and Shutter panels content**

LPM automatically offers a selection of predefined handles and shutter panels however it is possible to define your own handle and shutter panels using Palette Component options:

Please note that the custom-defined handle must be in the loaded libraries.
Predefined Door/Window handles

Door and Window Standard Fixtures and Fittings
The following standard ARCHICAD library door or window parametric elements and functionality will be added to each door or window automatically:

**Windows**
Wall Opening - Reveal
Wall Opening - Wall Closure
Wall Opening - Wall Inset
Wall Opening - Masonry Arch
Wall Opening – Attributes
Fixtures & Fittings – Sill
Fixtures & Fittings – Board
Fixtures & Fittings – Casing Inside/outside
Fixtures & Fittings – Sunshade
Fixtures & Fittings – Custom Corner
Fixtures & Fittings – Attributes

**Door**
Wall Opening - Reveal
Wall Opening - Wall Closure
Wall Opening - Masonry Arch
Fixtures & Fittings – Threshold
Fixtures & Fittings – Casing Inside/outside
Fixtures & Fittings – Sunshade
Fixtures & Fittings – Attributes
Library Part Maker Palette

The add-on palette is accessible from drop-down menu Design>Design Extras>Library Part Maker... or from Window>Palettes>Library Part Maker

Selecting and checking content for saving

Although you can use 3D window for element modelling the add-on commands are active in Plan window only. Before invoking LPM palette commands you have to select the saved content:

1. Show all required layers
2. Use Arrow tool for selecting all components of the library part.
3. Choose the library part type you wish to create from the palette menu
4. Check your selection for errors
5. Review the traffic light coded messages (red = critical error, library part cannot be created, yellow = non-critical warning, green = no issues found)
6. Use “Save As” button

Updating Existing Library Part

1. Select the updated content on plan
2. Use “Save As” button
3. Browse and select the existing library part to be updated
4. Note: Changes to Door/Window nominal sizes (Height, Width and Frame Width) will result in a new library part.

Follow the standard steps for property import and attribute management
Adjusting Library Part Parameters and Attributes

It is recommended to check and adjust all parameter names and values as well as fill in necessary identification information of the library part prior to saving. You can adjust the following:

Any parameter default value

Attribute parameter names

Data for Listing values

Change Library Part Details (Author, License, Password for script locking, Preview image, Description and Keywords)
System predefined parameters for Objects

**Dimension 1** – Overall object size along X axis
**Dimension 2** – Overall object size along Y axis
**Height** – Overall object size along Z axis
**Default Element Classification** – Classification used for IFC export

System predefined parameters for Doors and Windows

**Width** – width of Door/Window set
**Height** – height of Door/Window set
**Nominal Frame Thickness** – frame thickness of Door/Window set
**Orientation Displaying** – If set to ‘Automatic’ *Label Default Position* and *Label Reversed Position* values will be used for Door/Window labels and in Interactive Schedules. If set to ‘Custom’ the value of *Custom Orientation* parameter will be used instead.

**Custom Orientation** – used in conjunction with *Orientation Displaying* parameter
**Label Default Position** – (set to ‘L’ for ‘Left’ by default) used in conjunction with *Orientation Displaying* parameter
**Label Reversed Position** – (set to ‘R’ for ‘Right’ by default) used in conjunction with *Orientation Displaying* parameter
**IFC Operation** – IFC operation definition

*Surfaces*> **Door/Window Tolerance Outer Surface** – outer surface of tolerance infill
*Surfaces*> **Door/Window Tolerance Inner Surface** – inner surface of tolerance infill
*Surfaces*> **Door/Window Handle Surface** – surface of Door/Window handle(s)
*Pens*> **Opening Line Pen** – pen of Door/Window opening lines
Customising Data Properties

Creating Custom Property Schema

The custom schema can be defined by saving *LPM Listing Definition* subtype library part with required parameters into the loaded libraries folder.

1. Use the standard ARCHICAD command for creating new library part
   File>Libraries and Objects>New Object...
2. Set the Object’s subtype to *LPM Listing Definition*
3. Tick off ‘Placeable’ option
4. Define desired parameter names and their types in Parameters window
5. Save the library part with the name of your new schema in a loaded library
6. Reload the libraries with File>Libraries and Objects>Library Manager...

The new schema will appear in the drop down menu of LPM property sets.

Importing data from Excel spreadsheet

The custom schema together with already defined values can be imported directly from a Excel spreadsheet.
The Excel spreadsheet format
Refer to the add-on installation package that contains the Excel file Library Part Maker Property Schedule Template 19 located in ...GRAPHISOFT>Archicad19>Add-ons>Extras>LibraryPartMaker folder. The spreadsheet must be formatted to the format columnar with standard column header names...

Property Group
Used for grouping parameter headers in library part parameter definitions

Property Name
Used for parameter names truncating the actual name to 28 characters

ArchiCAD Data Type
Values in this column define ARCHICAD GDL parameter types. The definition values are limited to the following types:
  - Boolean
  - Real
  - Integer
  - Text
  - Length
  - Angle

..and any number of columns (e.g. Product 1 Data, Product 2 Data...Product n Data) with actual parameter values. The actual property value set (column) that will be used in the library part can be selected from Choose values to Import drop-down list.